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1. All information included in this document is current as of the date this document is issued. Such information, however, is 

subject to change without any prior notice. Before purchasing or using any Renesas Electronics products listed herein, please 
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and information in the design of your equipment.  Renesas Electronics assumes no responsibility for any losses incurred by 
you or third parties arising from the use of these circuits, software, or information. 

5. When exporting the products or technology described in this document, you should comply with the applicable export control 
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Electronics products or the technology described in this document for any purpose relating to military applications or use by 
the military, including but not limited to the development of weapons of mass destruction.  Renesas Electronics products and 
technology may not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited 
under any applicable domestic or foreign laws or regulations. 

6. Renesas Electronics has used reasonable care in preparing the information included in this document, but Renesas Electronics 
does not warrant that such information is error free.  Renesas Electronics assumes no liability whatsoever for any damages 
incurred by you resulting from errors in or omissions from the information included herein. 

7. Renesas Electronics products are classified according to the following three quality grades:  “Standard”, “High Quality”, and 
“Specific”.  The recommended applications for each Renesas Electronics product depends on the product’s quality grade, as 
indicated below.  You must check the quality grade of each Renesas Electronics product before using it in a particular 
application.  You may not use any Renesas Electronics product for any application categorized as “Specific” without the prior 
written consent of Renesas Electronics.  Further, you may not use any Renesas Electronics product for any application for 
which it is not intended without the prior written consent of Renesas Electronics.  Renesas Electronics shall not be in any way 
liable for any damages or losses incurred by you or third parties arising from the use of any Renesas Electronics product for an 
application categorized as “Specific” or for which the product is not intended where you have failed to obtain the prior written 
consent of Renesas Electronics.  The quality grade of each Renesas Electronics product is “Standard” unless otherwise 
expressly specified in a Renesas Electronics data sheets or data books, etc. 

“Standard”: Computers; office equipment; communications equipment; test and measurement equipment; audio and visual 
equipment; home electronic appliances; machine tools; personal electronic equipment; and industrial robots. 

“High Quality”: Transportation equipment (automobiles, trains, ships, etc.); traffic control systems; anti-disaster systems; anti-
crime systems; safety equipment; and medical equipment not specifically designed for life support. 

“Specific”:  Aircraft; aerospace equipment; submersible repeaters; nuclear reactor control systems; medical equipment or 
systems for life support (e.g. artificial life support devices or systems), surgical implantations, or healthcare 
intervention (e.g. excision, etc.), and any other applications or purposes that pose a direct threat to human life. 

8. You should use the Renesas Electronics products described in this document within the range specified by Renesas Electronics, 
especially with respect to the maximum rating, operating supply voltage range, movement power voltage range, heat radiation 
characteristics, installation and other product characteristics. Renesas Electronics shall have no liability for malfunctions or 
damages arising out of the use of Renesas Electronics products beyond such specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of its products, semiconductor products have 
specific characteristics such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Further, 
Renesas Electronics products are not subject to radiation resistance design.  Please be sure to implement safety measures to 
guard them against the possibility of physical injury, and injury or damage caused by fire in the event of the failure of a 
Renesas Electronics product, such as safety design for hardware and software including but not limited to redundancy, fire 
control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures.  Because 
the evaluation of microcomputer software alone is very difficult, please evaluate the safety of the final products or system 
manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental 
compatibility of each Renesas Electronics product.  Please use Renesas Electronics products in compliance with all applicable 
laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS 
Directive.  Renesas Electronics assumes no liability for damages or losses occurring as a result of your noncompliance with 
applicable laws and regulations. 

11. This document may not be reproduced or duplicated, in any form, in whole or in part, without prior written consent of Renesas 
Electronics. 

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this 
document or Renesas Electronics products, or if you have any other inquiries. 
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countries. 

 

The information in this document is current as of July, 2008. The information is subject to change 
without notice.  For actual design-in, refer to the latest publications of NEC Electronics data sheets or 
data books, etc., for the most up-to-date specifications of NEC Electronics products.  Not all 
products and/or types are available in every country.  Please check with an NEC Electronics sales 
representative for availability and additional information.
No part of this document may be copied or reproduced in any form or by any means without the prior       
written consent of NEC Electronics.  NEC Electronics assumes no responsibility for any errors that may 
appear in this document.
NEC Electronics does not assume any liability for infringement of patents, copyrights or other intellectual 
property rights of third parties by or arising from the use of NEC Electronics products listed in this document 
or any other liability arising from the use of such products.  No license, express, implied or otherwise, is 
granted under any patents, copyrights or other intellectual property rights of NEC Electronics or others.
Descriptions of circuits, software and other related information in this document are provided for illustrative 
purposes in semiconductor product operation and application examples. The incorporation of these 
circuits, software and information in the design of a customer's equipment shall be done under the full 
responsibility of the customer. NEC Electronics assumes no responsibility for any losses incurred by 
customers or third parties arising from the use of these circuits, software and information.
While NEC Electronics endeavors to enhance the quality, reliability and safety of NEC Electronics products, 
customers agree and acknowledge that the possibility of defects thereof cannot be eliminated entirely.  To 
minimize risks of damage to property or injury (including death) to persons arising from defects in NEC 
Electronics products, customers must incorporate sufficient safety measures in their design, such as 
redundancy, fire-containment and anti-failure features.
NEC Electronics products are classified into the following three quality grades: "Standard", "Special" and 
"Specific".  
The "Specific" quality grade applies only to NEC Electronics products developed based on a customer-
designated "quality assurance program" for a specific application.  The recommended applications of an NEC 
Electronics product depend on its quality grade, as indicated below.  Customers must check the quality grade of 
each NEC Electronics product before using it in a particular application.
 "Standard": Computers, office equipment, communications equipment, test and measurement equipment, audio

and visual equipment, home electronic appliances, machine tools, personal electronic equipment
and industrial robots.

"Special": Transportation equipment (automobiles, trains, ships, etc.), traffic control systems, anti-disaster
systems, anti-crime systems, safety equipment and medical equipment (not specifically designed
for life support).

"Specific": Aircraft, aerospace equipment, submersible repeaters, nuclear reactor control systems, life
support systems and medical equipment for life support, etc.

The quality grade of NEC Electronics products is "Standard" unless otherwise expressly specified in NEC 
Electronics data sheets or data books, etc.  If customers wish to use NEC Electronics products in applications 
not intended by NEC Electronics, they must contact an NEC Electronics sales representative in advance to 
determine NEC Electronics' willingness to support a given application.

(Note)
(1) "NEC Electronics" as used in this statement means NEC Electronics Corporation and also includes its 

majority-owned subsidiaries.
(2) "NEC Electronics products" means any product developed or manufactured by or for NEC Electronics (as 

defined above).
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•

•

•

•

•
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PREFACE 
 

 

Target Readers This manual is intended for customers using sample programs for the first time as well 

as customers using the 78K0S/Kx1+ microcontroller development tools for the first time.  

To use the development tools, basic knowledge on how to operate WindowsTM is 

required. 

 

Purpose This manual is intended for customers to understand how to use sample programs and 

the basic operation of the 78K0S/Kx1+ microcontroller development tools.  A deeper 

understanding of how to use sample programs and the basic operation of the 

development tools can be obtained when the tools are actually operated while reading 

this manual. 

 

Organization This manual consists of the following chapters. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The descriptions in chapter 2 and the following chapters use the sample program (initial 

setting) for the 78K0S/KB1+ microcontroller as an example. 

 

 

 

CHAPTER 3 REGISTERING INTEGRATED 
DEVELOPMENT ENVIRONMENT PM+ 
PROJECTS AND EXECUTING BUILD

CHAPTER 4 OPERATION CHECK USING SYSTEM 
SIMULATOR SM+ 

CHAPTER 2 PREPARING SAMPLE PROGRAMS

CHAPTER 1 PREPARING DEVELOPMENT 
ENVIRONMENT 

CHAPTER 5 MAIN SM+ FUNCTIONS

CHAPTER 6  RELATED DOCUMENTS

APPENDIX  REVISION HISTORY

From preparing the 
development 
environment to 
checking the operation 
of the sample program 



 

Application Note  U18787EJ2V0AN 4 

CHAPTER  1   PREPARING  DEVELOPMENT  ENVIRONMENT 
 

 

This chapter describes the preparation of the development environment. 

 

1.1 Relation Between the Development Procedure and the Development Tools 
 

The following figure shows the development procedure and development tools. 

 

Product planning

System design

Hardware design

Production

Inspection

System debugging

System evaluation

Commercialization

Failure?

Software design

Coding

Compiling/
assembling

Error?
Yes

Yes

Yes

No

No

No

Debug

Edit

Build
Debug

Editor

ID-78K0S-xx 
(integrated 
debugger)

Bug?

CC78K0S (compiler)/
RA78K0S (assembler)

SM+ for 78K0S/Kx1+ 
(system simulator)

In-circuit emulator

PM+ (integrated 
development 
environment)

Development tools 
(software)

Applilet

Development tool (hardware)

Development procedure

 
 

To check the operation of a sample program, the development tools in the shaded ovals  are used. 
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1.2 Configuration of Development Environment 
 

To check the operation of a sample program, the following development tools must be installed. 

 

(1) Device file 

This file contains device-specific information.  It is used in combination with each tool (CC78K0S, RA78K0S, 

SM+ for 78K0S/Kx1+). 

 

(2) CC78K0S (C compiler) 

This is a highly versatile and portable C compiler developed for coding embedded control programs for the 

78K0S microcontroller in C language.  PM+ is required to operate CC78K0S on Windows. 

 

(3) RA78K0S (assembler) 

RA78K0S generates an execution code that can be executed from the assembler source program using the 

78K0S microcontroller.  PM+ is required to operate RA78K0S on Windows. 

 

(4) PM+ (integrated development environment) 

This is an integrated development environment to be used on Windows.  It enables efficient development by 

operating in combination with development tools, such as editors, compilers, and debuggers. 

 

(5) SM+ for 78K0S/Kx1+ (system simulator) 

SM+ for 78K0S/Kx1+ simulates the execution code created for the 78K0S/Kx1+ microcontroller, on the host PC. 

 

To obtain the above tools, contact your sales representative. 

 

 

 

 

 



 

Application Note  U18787EJ2V0AN 6 

CHAPTER  2   PREPARING  SAMPLE  PROGRAMS 
 

 

This chapter describes the preparation of the sample programs. 

 

2.1 Downloading Sample Programs 
 

The sample programs for the 78K0S/Kx1+ microcontroller can be obtained from the following Web site. 

 

→ http://www.necel.com/micro/en/designsupports/sampleprogram/78k0s/low_pin_count/index.html 

 

 

<78K0S/KB1+ microcontroller sample program (initial setting)> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select “Initial 
Setting”. 

Select “78K0S/KB1+”. 

Application Note 

(*.pdf) 

Only source files 

(*.zip) 

Include files to be used 
with PM+ as well as 
SM+ for 78K0S/Kx1+ 
(*.zip)

Include microcontroller 
operation simulation 
files to be used with 
SM+ for 78K0S/Kx1+ 
(*.zip) 

http://www.necel.com/micro/en/designsupports/sampleprogram/78k0s/low_pin_count/index.html
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Click  to open a PDF file (Application Note). 

Click ,  ,  to launch the download dialog box of a compressed file.  Click the [Save] button to save the file 

to a desired location.  Decompress the file after saving it. 

<Downloading and decompressing a sample program (compressed file)> 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

Select a desired location (“download” 
folder in this example). 

Click 

Right-click and select [Extract 

All] from the pull-down menu. Decompress the file in accordance 
with the following dialog boxes. 

Click 
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2.2 File Configuration 
 

The following files can be downloaded from among the files listed in the table of sample programs. 

 

:  Application Note (PDF file) 

:  Only the source file is included (ZIP file). ⇒ <Procedure 3.1.1 → 3.2 → 4.1.1 → 4.1.3 → 4.2> 

:  The files to be used with integrated development environment PM+ and system simulator SM+ for

78K0S/Kx1+ are included (ZIP file).   ⇒ <Procedure 3.1.2 → 3.2 → 4.1.2 → 4.2> 

:  The microcontroller operation simulation file to be used with system simulator SM+ for 78K0S/Kx1+ is 

included (ZIP file).   ⇒ <Procedure 4.1.3> 

 

The configuration of the files to be downloaded is as follows. 

 

 PDF (*.pdf) 

File 
Compressed (*.zip) File Included File Name Description 

    

UxxxxxxxxxxANxx.pdf Application Note of sample program     

main.asm (Assembly 

language version) 

main.c (C language 

version) 

Source file for hardware initialization 

processing and main processing of 

microcontroller 

 Note 1 Note 1  

op.asm Assembler source file for setting the option 

byte (sets the system clock source) 
    

xxx.prw Work space file for integrated development 

environment PM+ 
    

xxx.prj Project file for integrated development 

environment PM+ 
    

xxx.pri 

xxx.prs 

xxx.prm 

Project file for system simulator SM+ for 

78K0S/Kx1+ 
  Note 2  

xxx.pnl I/O panel file for system simulator SM+ for 

78K0S/Kx1+ (used for checking peripheral 

hardware operations) 

  Note 2  

xxx0.wvo Timing chart file for system simulator SM+ for 

78K0S/Kx1+ (used for checking waveforms) 

  Note 3  

 

Notes 1. “main.asm” is included with the assembly language version, and “main.c” with the C language version. 

 2.  SM+ for 78K0S/Kx1+ is not supported with the 78K0S/KU1+ microcontroller (as of July, 2008).  It is 

therefore not included with the 78K0S/KU1+ microcontroller. 

 3. This compressed file (source files + project file) does not include “xxx0.wvo”, but it need not be 

additionally downloaded, because the timing chart itself is saved into the project file. 
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CHAPTER  3   REGISTERING  INTEGRATED  DEVELOPMENT  ENVIRONMENT  PM+  PROJECTS 
AND EXECUTING  BUILD 

 

 

This chapter describes how to register integrated development environment PM+ projects and how to execute build, 

using the 78K0S/KB1+ microcontroller sample program (initial setting) as an example.  A project must be registered 

before executing build in PM+. 

 

Remark For the details of how to operate PM+, refer to the PM+ Project Manager User’s Manual. 

 

3.1 Project Registration 
 

The project registration method varies, depending on the file to be downloaded. 

 

3.1.1 Project registration (only source files) 

This section describes how to register a project, using the assembly language source file that has been 

downloaded by clicking the  icon of the 78K0S/KB1+ microcontroller sample program (initial setting). 

 

(1)  Start PM+. 

 

(2)  Select [New Workspace] from the [File] menu. 

 

 

 

 

 

 

 

 

 

(3)  The [New WorkSpace - Step 1/9 [Workspace Information]] dialog box will be displayed.  Set the following items. 

 

(a)  Workspace File Name 

Specify the name of the file to which the workspace information is to be saved.  (In the example shown 

below, the file name is entered as “initial”.) 

 

(b)  Folder 

Specify the folder in which the workspace file and project file are to be saved.  Click the [Browse] button to 

open the [Browse for Folder] dialog box and specify any folder.  (In the example below, the arbitrarily 

created “work” folder under the default folder (“bin” folder in which PM+ is located) is specified.) 

 

(c)  Project Group Name 

Specify the name of the project group to be displayed on the Project window.  (In the example below, the 

group name is entered as “Initialization”.) 

 

http://www.necel.com/cgi-bin/nesdis/o002_e.cgi?title=PM%2b%2a
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(d)  Microcontrollers Name 

To use the 78K0S/Kx1+ microcontroller sample program, select “78K0S” from the drop-down list displayed 

by clicking [▼]. 

 

(e)  Device Name 

Select the sample program of the product to be used.  Select from the drop-down list displayed the name 

of the device to be used, by clicking [▼].  (In the example below, the 78K0S/KB1+ microcontroller product 

“uPD78F9232” is selected.) 

 

After setting items (a) to (e), click the [Next] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(4) The [New WorkSpace - Step 2/9 [Select Tools]] dialog box will be displayed.  Set the tool versions in the order 

of the following procedure. 

<1> Click the [Detail Setting] button. 

<2> The [Tool Version Detail Setting] dialog box will be displayed.  Set the RA78K0S version to W2.00 or later 

and click the [OK] button.Note 

<3> The tools and their versions selected in step <2> will be set.  Click the [Next] button. 

 

Note To use the C language source file, set the CC78K0S version to W2.01 or later. 

 

(a) Enter the file name (“initial” in this example). 

(d) Select “78K0S” for 
the microcontroller name 
(click [▼] and select it 
from the drop-down list). 

Click the [Next] button after setting items (a) to (e). 
(e) Select the device name 
(click [▼] and select it from 
the drop-down list). 

(b) Specify the folder 
location (click [Browse], 
select a folder, and click 
[OK]). 

(c) Enter the group name 
(“Initialization” in this 
example). 
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(5)  The [New WorkSpace - Step 7/9 [Setup Source Files]] dialog box will be displayed.  Set the source files in the 

order of the following procedure. 

<1>  Click the [Add] button. 

<2> The [Add Source Files] dialog box will be displayed.  Select the source files and click the [Open] button.  

(In the example below, “main.asm” and “op.asm” are selected from the location where the files have been 

decompressed in CHAPTER 2 PREPARING SAMPLE PROGRAMS, and the [Open] button is clicked.) 

<3> The source files selected in step <2> will be specified.  Click the [Next] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<1> Click the [Add] button. 

<3> Click the [Next] button. 

<2> Select the folder, select the 
 source files, and click the 
 [Open] button. 

<1> Click the [Detail Setting] button. 

<2> Set the RA78K0S version to W2.00 or later 
and click the [OK] button. 

<3> Click the [Next] button. 
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(6)  The [New WorkSpace - Step 8/9 [Select Debugger]] dialog box will be displayed.  Click the [Next] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(7)  The [New WorkSpace - Step 9/9 [Confirmation]] dialog box will be displayed.  Confirm the settings and click the  

 [Finish] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

Click 



CHAPTER  3   REGISTERING  INTEGRATED  DEVELOPMENT  ENVIRONMENT  PM+  PROJECTS AND EXECUTING  BUILD 

Application Note  U18787EJ2V0AN 13

(8)  A workspace will be created and the project will be registered.  Perform build operation after project registration.  

(Refer to 3.2 Executing Build.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(9) To save the information of the currently opened workspace and project with the same file name, do so in the 

following manner. 

• Select [Save Workspace] from the [File] menu (to save the workspace while it is kept opened). 

• Select [Close Workspace] from the [File] menu (to close and save the workspace). 

• Select [Exit PM+] from the [File] menu (to terminate PM+ after saving the workspace). 

 

Remarks 1. After starting PM+ for the second time, PM+ is set to automatically start the previous project by 

default when PM+ is started. 

 2. After project registration, the following settings can be changed by selecting [Project Settings] from 

the [Project] menu. 

• Changing the project title (In the example below, “Initialization” is changed to “C”.) 

• Changing the device file (In the example below, “uPD78F9232” is changed to “uPD78F9234”.) 

• Adding and deleting source files (In the example below, “main.asm” is changed to “main.c”.) 

• Setting the tools and their versions 

 

Workspace file name 

Project group name 

Project title name (This is the same as 
the project group name, when a project 
is newly created.) 



CHAPTER  3   REGISTERING  INTEGRATED  DEVELOPMENT  ENVIRONMENT  PM+  PROJECTS AND EXECUTING  BUILD 

Application Note  U18787EJ2V0AN 14 

 

 

 

 

 

 

 

 

 

 

 

Change the source files by 
clicking [Add] and [Remove] 
(In this example, “main.asm” 
is changed to “main.c”). 

Click the [Source File] tab 
after changing the settings. 

Change the title name (In this 
example, “Initialization” is 
changed to “C”). 

Change the device name (In this 
example, “uPD78F9232” is 
changed to “uPD78F9234”). 

Click [Yes]. 

Click [OK] after 
changing the 
settings. Displayed when the 

device name is changed
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3.1.2 Project registration (source files and project file) 

This section describes how to register a project, using the assembly language sample program (source program + 

project file) that has been downloaded by clicking the  icon of the 78K0S/KB1+ microcontroller sample program 

(initial setting). 
 

(1)  Start PM+. 
 

(2)  Select [Open Workspace] from the [File] menu. 

 

 

 

 

 

 

 

 

(3)  The [Open Workspace] dialog box will be opened.  Select a workspace file (*.prw) and click the [Open] button.  

(In the example below, “initial.prw” is selected from the location where the files have been decompressed in 

CHAPTER 2 PREPARING SAMPLE PROGRAMS, and the [Open] button is clicked.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

(4)  The project will be registered.  After project registration, check the device file set by default and change the 

setting as required.  Select [Project Settings] from the [Project] menu. 

 

 

 

 

 

 

 

 

 

 

Select the folder, select the 
workspace file (*.prw), and click the 
[Open] button. 
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(5) The [Project Settings] dialog box will be displayed.  The device with the largest ROM or RAM size  

 (“uPD78F9234” in the example below) is set as the Device Name by default.  Select the device name to be  

 used (“uPD78F9232” in the example below) and click the [OK] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(6)  The device file will be changed.  After changing the device file, perform build operation.  (Refer to 3.2 Executing 

Build.) 

 

(7) To save the information of the currently opened workspace and project with the same file name, do so in the 

following manner. 

• Select [Save Workspace] from the [File] menu (to save the workspace while it is kept opened). 

• Select [Close Workspace] from the [File] menu (to close and save the workspace). 

• Select [Exit PM+] from the [File] menu (to terminate PM+ after saving the workspace). 

 

Remarks 1. After starting PM+ for the second time, PM+ is set to automatically start the previous project by 

default when PM+ is started. 

 2. After project registration, the following settings can be changed by selecting [Project Settings] from 

the [Project] menu. 

• Changing the project title 

• Changing the device file 

• Adding and deleting source files 

• Setting the tools and their versions 

  For details, refer to Remark 2 in 3.1.1.  (Refer to (4) to (6) in 3.1.2 when only changing the device 

files.) 

 

 [Column] Tab width in a source program 

The source of a sample program is set to be easy to view when the tab width is set to eight characters.  It 

is recommended to change the setting by the following procedure, because with PM+ the tab width is set to 

four characters by default. 

<1> Select [PM+ Settings] from the PM+ [Tool] menu. 

<2> The PM+ Settings dialog box will be displayed.  Click the [View] tab. 

<3> Set [Memorize number of Tab characters each Window] to “8” and click the [OK] button. 

Select the device name
Click the [OK] button

Click 

Displayed when the 
device name is changed
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3.2 Executing Build 
 

After performing the settings described in 3.1.1 or 3.1.2, execute build by clicking the buttons on the build bar. 

When build is executed, a HEX file (*.hex) is created in the folder in which the workspace file (*.prw) is located.  If a 

programming environment is available, the HEX file can be written to the microcontroller flash memory. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
(a) [Build] button ( ) 

Click the [Build] button to execute build.  When the source files are built normally, the message “I3500: Build 

completed normally.” will be displayed.  Click the [OK] button.   

 

 

 

 

 

 

 

 

 

 

 

 

(a) [Build] button 

(b) [Rebuild] button 

Click 

4.1 Starting SM+ 

Click 
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(b)  [Rebuild] button ( ) 

Click the [Rebuild] button to execute rebuild.  When the source files are rebuilt normally, the message “I3500: 

Build completed normally.” will be displayed.  Click the [OK] button.   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[Column] Build errors 

Change the compiler option setting according to the following procedure when the error message “A006 

File not found ‘C:\NECTOOLS32\LIB78K0S\s0sl.rel’” or “*** ERROR F206 Segment ‘@@DATA’ can’t 

allocate to memory - ignored.” is displayed, when building with PM+. 

 

<1> Select [Compiler Options] from the [Tool] menu. 

<2> The [Compiler Options] dialog box will be displayed.  Select the [Startup Routine] tab. 

<3> Uncheck the [Using Fixed Area of Standard Library] check box.  (Leave the other check boxes as they 

are.) 

 

A RAM area of 118 bytes that has been secured as a fixed standard library area will be enabled for use 

when the [Using Fixed Area of Standard Library] check box is unchecked; however, the standard libraries 

(such as the getchar function and malloc function) will be disabled for use. 

The [Using Fixed Area of Standard Library] check box is unchecked by default when the file that has been 

downloaded by clicking the            icon is used in this sample program. 

Click 

4.1 Starting SM+ 

Click 
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CHAPTER  4   OPERATION  CHECK  USING  SYSTEM  SIMULATOR  SM+ 
 

 

This chapter describes how a sample program operates with system simulator SM+ for 78K0S/Kx1+, using the 

78K0S/KB1+ microcontroller sample program (initial setting) as an example. 

 

Caution SM+ for 78K0S/Kx1+ is not supported with the 78K0S/KU1+ microcontroller (as of July, 2008).  

The operation of the 78K0S/KU1+ microcontroller therefore cannot be checked with SM+ for 

78K0S/Kx1+. 

 

4.1 Starting SM+ 
 

When SM+ for 78K0S/Kx1+ W1.02 (hereinafter “SM+”) is used in an environment of PM+ Ver. 6.30, SM+ cannot be 

selected as the debugger.  In this case, start SM+ using method (a) or (b) described below, while keeping PM+ 

running after building a project has been completed. 

 

(a) When starting SM+ in PM+ 

<1> Select [Register Ex-tool] from the [Tool] menu and register “SM+ for 78K0S/Kx1+”. 

<2> Select [Ex-tool Bar] from the [View] menu to display the SM+ icon on the PM+ toolbar. 

<3> Start SM+ by clicking the SM+ icon. 

(See the PM+ help for details of how to register external tools.) 

 

(b) When not starting SM+ in PM+ 

• Start SM+ from the Windows start menu. 

 

When SM+ is started, the start screen differs depending on the downloaded file. 
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4.1.1 SM+ start screen (only source files) 

 

(1) When SM+ is started, the [Configuration] dialog box will be opened.  Click the [OK] button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remark Set the clock frequency and other settings in the [Configuration] dialog box, depending on the 

program.  Such settings are not required in the sample program (initial setting) example shown 

above, because a high-speed internal oscillator is used. 

 

(2) The message “Wf700: Do you want to download Load Module File?” will be displayed.  Click the [Yes] button. 

 

 

 

 

 

 

 

        Click 

Click 

Click 
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(3) The Main window of SM+ will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.1.2 SM+ start screen (source files and project file) 

When SM+ is started, the Main window ([Source] window + simulation windows) will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Only the [Source] 
window will be opened, 
because the simulator 
file of SM+ has not 
been prepared. 

4.1.3 Opening a simulation file  
(only source files) 

Click 

The [Source] window and 
simulation windows will be 
opened, because the simulator file 
of SM+ has been prepared. 

4.2 Simulation 
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4.1.3 Opening a simulation file (only source files) 

When only source files are downloaded (by clicking ), only the [Source] window will be opened in the Main 

window of SM+. 

The simulation windows are added in the Main window of SM+ by using a simulation file (downloaded by clicking 

).  They are added through the following procedure. 
 

(1) Select [Open] from the [Simulator] menu to open the dialog box for selecting a simulation file.  Change [Files of 

type] to “All Files (*.*)”, select a simulation file, and click the [Open] button.  (In the example shown below, 

“initial0.pnl” and “initial0.wvo” are selected from the location where the files have been decompressed in 

CHAPTER 2 PREPARING SAMPLE PROGRAMS, and the [Open] button is clicked.) 
 

Caution Multiple files cannot be selected in the file selection dialog box.  When multiple simulation 

files have been prepared, open the simulation windows by selecting one file at a time. 

 

 

 

 

 

 

 

 

 

 

[I/O Panel] 
window 

Select the folder, select the I/O 
panel file (*.pnl), and click the 
[Open] button. 

Select the folder, select the 
timing chart file (*.wvo), and 
click the [Open] button. 
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(2) The simulation windows will be added in the Main window of SM+.  (In the example shown below, the [I/O 

Panel] window and [Timing Chart] window are added.) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Remark When source files and a project file have been downloaded (by clicking ), the simulation 

windows will be automatically opened in the Main window of SM+ which is started after build 

execution, because an SM+ simulator file has been prepared in advance. 

 

[I/O Panel] 
window 

[Timing Chart]  
window 

4.2 Simulation 
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4.2 Simulation 
 

This section confirms how the 78K0S/KB1+ microcontroller sample program (initial setting) operates, by using the 

SM+ simulation functions. 

 

Remark For the details of how to operate SM+, refer to the SM+ System Simulator Operation User’s Manual. 

 

(1)  Click  ([Restart] button).  The program will be executed after the CPU is reset and the following screen will 

be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This turns 
red during 
program 
execution. 

      Click 

http://www.necel.com/cgi-bin/nesdis/o002_e.cgi?article=SM%2a&title=SM%2b%2aoperation
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(2) Click the [SW1] and [SW2] buttons in the [I/O Panel] window, during program execution.  Check the lighting of 

 [LED1] to [LED3] in the [I/O Panel] window, as well as the waveforms in the [Timing Chart] window change, 

 depending on the combination of the [SW1] and [SW2] buttons. 

Example 1.  SW1: ON, SW2: OFF 
[I/O Panel] window [Timing Chart] window 

 

 

 

 
 

 

Example 2.  SW1: OFF, SW2: ON 
[I/O Panel] window [Timing Chart] window 

 

 

 

 
 

 

Example 3.  SW1: ON, SW2: ON 
[I/O Panel] window [Timing Chart] window 

 

 

 

 
 

 

Example 4.  SW1: OFF, SW2: OFF 
[I/O Panel] window [Timing Chart] window 

 

 

 

 
 

Remark   H: High level, L: Low level 

ON 

Only LED1 lights up 

P40: L input 

P43: H input 

P20: L output 

P21: H output 

P22: H output 

ON 

Only LED2 lights up 

P40: H input 

P43: L input 

P20: H output 

P21: L output 

P22: H output 

ON 

Only LED3 lights up 

P40: L input 

P43: L input 

P20: H output 

P21: H output 

P22: L output 
ON 

OFF 

All LEDs turn off 

P40: H input 

P43: H input 

P20: H output 

P21: H output 

P22: H output 
OFF 

OFF 

OFF 
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[Supplement] The changes in the data values of ports 2 and 4 can be checked by using the SM+ watch function 

(refer to 5.6  [Watch] Window). 

<1> Select [Watch] from the [Browse] menu to open the [Watch] window. 
<2> Click [Add] to open the [Add Watch] window.  (At this time, the [Watch] window is kept opened.) 

<3> Enter “P4” in the [Name] field and click the [Add] button to register “P4” in the [Watch] window.  (At this 

time, the [Add Watch] window is kept opened.) 
<4> Next, enter “P2” in the [Name] field and click the [OK] button to register “P2” in the [Watch] window and 

close the [Add Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
<5> Execute the program and click the [SW1] and [SW2] buttons in the [I/O Panel] window.  Check that the 

data values of P2 and P4 in the [Watch] window change, depending on the combination of the [SW1] and 
[SW2] buttons. 

Combination of SW1 and SW2 Data Value in [Watch] Window 

SW1: ON, SW2: OFF P2: 0x06, P4: 0x08 

SW1: OFF, SW2: ON P2: 0x05, P4: 0x01 

SW1: ON, SW2: ON P2: 0x03, P4: 0x00 

SW1: OFF, SW2: OFF P2: 0x07, P4: 0x09 
 

P2 and P4 are 
registered. 

This is an example of the screen after 
CPU reset.  The data values of P2 and 
P4 are as follows after CPU reset. 
• P2: 0x00 
• P4: 0x10 

Click 

Enter “P4”, then click 
the [Add] button. 

Enter “P2”, then click the 
[OK] button. 
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CHAPTER  5   MAIN  SM+  FUNCTIONS 
 

 

This chapter describes the main functions of the SM+ windows. 

 

Remark For the details of how to operate SM+, refer to the SM+ System Simulator Operation User’s Manual. 

 

5.1 [Source] Window 
 

This window is used to display source files or text files. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)  Point mark area 

This area is used for the event setting status and program code display, as well as breakpoint setting. 

A breakpoint can be set by clicking the asterisk (“*”) of the location to which it is to be set. 

 

 

 

 

 

 

 

 

 

 

 

(a) Point mark 
 area 

(b) Current PC 
 mark area 

(c) Line  number/address 
 display area 

(d) Source text display 
area

(e) Function buttons 

       Click 

The line to which a valid breakpoint is set 
is displayed in red. 

Changed to 
“B” 

http://www.necel.com/cgi-bin/nesdis/o002_e.cgi?article=SM%2a&title=SM%2b%2aoperation
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(b) Current PC mark area 

The “>” mark, which indicates the current PC value (PC register value), is displayed in this area.  By double-

clicking this area, the user program can be executed up to the double-clicked line. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(c)  Line number/address display area 

This area displays the line number of a source file or text file. 

 

(d)  Source text display area 

This area displays source texts and text files. 

Yellow indicates the current PC line, and red indicates lines where a valid breakpoint is set. 

 

(e) Function buttons 

Search… Searches a character string (opens the [Source Search] dialog box). 

<< Searches forward (upward on screen) for the specified character string. 

>> Searches backward (downward on screen) for the specified character string. 

Stop (during a search) Stops searching. 

Watch Adds contents, such as a selected variable, to the [Watch] window. 

Quick… Temporarily displays the contents, such as a selected variable, in the [Quick Watch] dialog box. 

Refresh Updates the contents of the window with the latest data. 

Close Closes the [Source] window. 

 

Double-click 

The program is 
executed up to 
the double-
clicked line. 

The current PC line is 
displayed in yellow. 
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Click the following buttons on the toolbar to execute the source program displayed on the [Source] window. 

 

 

(Stop) 

Stops execution during user program execution. 

Same function as selecting [Stop] from the [Run] menu. 

 

(Restart) 

Resets the CPU and executes the user program. 

Same function as selecting [Restart] from the [Run] menu. 

 

(Go) 

Executes the user program from the current PC without resetting the CPU. 

Same function as selecting [Go] from the [Run] menu. 

 
(Ignore break 
point and Go) 

Ignores the set breakpoints and executes the user program. 

Same function as selecting [Ignore break points and Go] from the [Run] menu. 

 

(Return) 

The user program is executed until execution returns. 

Same function as selecting [Return Out] from the [Run] menu. 

Caution This command is used for functions described in C language. 

 

(Step in) 

Step execution (executes instructions in the program one by one.)  If a function or subroutine is 

called, its instructions are executed one by one. 

Same function as selecting [Step In] from the [Run] menu. 

 

(Next Over) 

Next step execution (executes the program, assuming a function/call statement as one step.)  If a 

function or subroutine is called, its instructions are not executed on a step-by-step basis. 

Same function as selecting [Next Over] from the [Run] menu. 

 

(CPU Reset) 

Resets the CPU. 

Same function as selecting [CPU Reset] from the [Run] menu. 

 

The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [Source] window.  

The three main functions that can be selected from the context menu are described next. 
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Enter “P2” (P2 register) and 

click the [OK] button. 

<1> Mix 

Select [Mix] from the context menu (displayed by right-clicking anywhere on the [Source] window) for a 

combined display of the source file and the disassembly of the program on the [Source] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<2> Add Watch 

Select [Add Watch] from the context menu (displayed by right-clicking anywhere on the [Source] window) to 

open the [Add Watch] dialog box.  Specify the data and click the [OK] button in this dialog box to register the 

specified data in the [Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Normal display 

(default) 

Mixed display 

Disassembly line 

“P2” is 
registered. 
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<3>  Come Here 

Select [Come Here] from the context menu (displayed by right-clicking anywhere on the [Source] window) to 

execute the program, from the address indicated by the current PC register up to the address where the 

cursor has been placed, after which a break occurs. 

While the program is being executed, the break event currently set does not occur. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.2 [Timing Chart] Window 
 

This window displays in the form of a timing chart input signals and output signals for pins. 

 

 

 

 

 

 

(a) Pin area (b) Waveform area 

(d) Information bar (c) Marker area 

Current PC line 

Line to which a 

breakpoint is set 

Cursor position 

The program is executed 
up to the address where 
the cursor is placed, and 

then a break occurs. 
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(or) 

 Enter the function name 
after the change 
Click the [OK] button

(or) 

Click 

(a) Pin area 

This area displays the names of pins to be displayed in the [Timing Chart] window. 

Select [Select Pin] from the context menu (displayed by right-clicking anywhere on the (b) Waveform area), 
select [Select Pin] from the [Edit] menu, or click the  button on the toolbar to open the [Select Pin] dialog 

box.  Items, such as pin names, can be changed in this dialog box. 

 

 

 

 

 

 

 

 

 

 

 

 

Pin name 
change 
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(or) 

(b) Waveform area 

This area displays as a timing chart the data of the pins specified in the (a) Pin area. 

The magnification of the timing chart display can be selected by selecting [Zoom] from the [View] menu or 
using  on the toolbar. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(c) Marker area 

This area displays the headers of markers A and B. 

The markers can be set by selecting [Move markerA] and [Move markerB] from the context menu (displayed by 

right-clicking anywhere on the (b) Waveform area).  The placed markers can be dragged to the desired 

locations. 

×1 display 

×2 display 

Display magnification 
change 
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(d)  Information bar 

This area can be displayed or hidden via the [View] menu or the [Information bar]. 

 

 Displays the time from the simulation start to the marker A location. 

 Displays the time from the simulation start to the marker B location. 

 Displays the time between markers A and B as an absolute value. 

 Displays the unit of the time information. 

 

The unit of the time information displayed on the Information bar can be changed by selecting [Time Unit] from the 

[Edit] menu. 

 

 

 

 

 

 

 

 

Place marker A. 

Drag the marker to any location. 

Unit 
The unit of numerical 
values is “μs”.
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  Click 

(or) 

Click 

(or) 

5.3 [I/O Panel] Window 
 

This window is used to create a pseudo target system.  This window is used to display and manipulate connected 

parts. 

 

 

 

 

 

 

 

 

 

 

 

 

Click  on the toolbar or select [Select] from the [Figure] menu to select an object in the [I/O Panel] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click  on the toolbar or select [Simulation Mode] from the [Figure] menu to select an object in the [I/O Panel] 

window or to simulate the input to a connected part. 

 

 

 

 

 

[I/O Panel] 
window 

The mouse cursor changes to an arrow with 
which an object can be selected (In this figure, 
[LED1] is selected). 

The mouse cursor changes to a hand image with which 
the input to a connected part can be simulated (In this 
figure, the [SW1] switch is input). 
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The connected parts can be added to the [I/O Panel] window by clicking the following buttons on the toolbar.  By 

double-clicking the connected parts in the [I/O Panel] window, the dialog box opens and the information of the 

connected parts can be set. 

 

 

(Button creation) 

Switch 

A button can be connected to any pin.  An input value can be given to the connected pin by clicking the 
displayed button. 

Same function as selecting [Button] from [Parts] on the menu bar. 

 

(Key matrix 
creation) 

A key matrix consists of multiple pins connected in a matrix array, wherein each contact represents a key, 
and clicking a key results in a specific state. 

A key matrix can be connected to any pin, and data can be input using multiple keys. 

Same function as selecting [Key Matrix] from [Parts] on the menu bar. 

 

(Level gauge 
creation) 

Used for inputting analog data, such as power supply voltage.  Any data within a given range can be set. 

Any value within a specified range can be assigned to a pin connected to an A/D converter. 

Same function as selecting [Level Gauge] from [Parts] on the menu bar. 

 

(LED creation) 

LED (Light Emitting Diode) 

An LED can be connected to any pin, and the output from the pin can be indicated by switching the LED on 
or off. 

Same function as selecting [LED] from [Parts] on the menu bar. 

 

(7-segment LED 
creation) 

A product that consists of 7 LEDs configured to represent a numeric figure. 

When the output from the pin to which the digit signal is assigned is active, the corresponding 7-segment 
LED switches on or off. 

Same function as selecting [7-segment LED] from [Parts] on the menu bar. 

 

(14-segment LED 
creation) 

A product that consists of 14 LEDs configured to represent an alphabetic character. 

When the output from the pin to which the digit signal is assigned is active, the corresponding 14-segment 
LED switches on or off. 

Same function as selecting [14-segment LED] from [Parts] on the menu bar. 

 

(Matrix LED 
creation) 

A product that consists of multiple LEDs arranged in a matrix array. 

When the output from the pin to which the digit signal is assigned is active, the corresponding matrix LED 
switches on or off. 

Same function as selecting [Matrix LED] from [Parts] on the menu bar. 

 

(Buzzer creation) 

Buzzer 

A buzzer connected to a pin indicates with a bitmap or buzzer sound the output information from the 
connected pin. 

Same function as selecting [Buzzer] from [Parts] on the menu bar. 

An example of the display of the connected parts is shown below. 

 

 

 

Button 

Key matrix 

Level gauge 

LED 

        7-segment LED 

14-segment LED 

Matrix LED 

Buzzer 
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5.4 [Assemble] Window 
 

This window is used to display the disassembly of a program.  Select [Assemble] from the [Browse] menu or click 
the  button on the toolbar to open the [Assemble] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)  Point mark area 

This area is used for the event setting status display and breakpoint setting.  A breakpoint can be set by 

clicking the asterisk (“*”) of the location to which it is to be set. 

 

(b)  Current PC mark area 

The “>” mark, which indicates the current PC value (PC register value), is displayed in this area.  By double-

clicking this area, the user program can be executed up to the double-clicked line. 

 

(c)  Address specification area 

This area displays the disassembly start address. 

 

(d)  Disassemble display area 

This area displays the labels and code data of addresses, and disassembled mnemonics. 

Yellow indicates the current PC line, and red indicates lines where a valid breakpoint is set. 

 

(e)  Function buttons 

Search… Searches a character string (opens the [Assemble Search] dialog box). 

<< Searches forward (upward on screen) for the specified character string. 

>> Searches backward (downward on screen) for the specified character string. 

Stop (during a search) Stops searching. 

Watch Adds contents, such as a selected variable, to the [Watch] window. 

Quick… Temporarily displays the contents, such as a selected variable, in the [Quick Watch] dialog box. 

Refresh Updates the contents of the window with the latest data. 

Close Closes the [Assemble] window. 

(a) Point mark area 

(b) Current PC mark area 

(c) Address specification area 
(d) Disassemble display area 

(e) Function buttons 
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Enter “00C8” and click the 
[OK] button. 

 

The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [Assemble] 

window.  The three main functions that can be selected from the context menu are described next. 

 

<1>  Move 

Select [Move] from the context menu (displayed by right-clicking anywhere on the [Assemble] window) to 

open the [Address Move] dialog box.  Specify an address value and click the [OK] button in this dialog box to 

move the disassembly start address to the specified address value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Moved 
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<2>  Add Watch 

Select [Add Watch] from the context menu (displayed by right-clicking anywhere on the [Assemble] window) 

to open the [Add Watch] dialog box.  Specify the data and click the [OK] button in this dialog box to register 

the specified data in the [Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<3>  Come Here 

Select [Come Here] from the context menu (displayed by right-clicking anywhere on the [Assemble] window) 

to execute the program, from the address indicated by the current PC register up to the address where the 

cursor has been placed, after which a break occurs. 

While the program is being executed, the break event currently set does not occur. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Current PC line 

Line to which a 

breakpoint is set 

Cursor 
position 

The program is executed up to 
the address where the cursor is 

placed, and then a break occurs. 

“P2” is registered. 

Enter “P2” (P2 register) and 

click the [OK] button. 
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Enter “FF”. 

Press the Enter key. 

5.5 [Memory] Window 
 

This window is used to display memory contents.  Select [Memory] from the [Browse] menu or click the  button 

on the toolbar to open the [Memory] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)  Address display area 

This area displays memory addresses. 

 

(b)  Memory display area 

This area is used to display and change memory contents. 

Memory contents are changed through direct entry.  Changes are displayed in red and the contents of the 

changes are written to the target memory by pressing the Enter key.  The previous values can be discarded by 

pressing the ESC key.  Up to 256 bytes can be changed at one time. 

 

 

 

 

 

 

 

(c) Function buttons 

(a) Address display area (b) Memory display area 



CHAPTER  5   MAIN  SM+  FUNCTIONS 

Application Note  U18787EJ2V0AN 41

(c)  Function buttons 

Search… Searches a character string or memory contents (opens the [Assemble Search] dialog box). 

<< Searches forward (upward on screen) for the specified character string or memory contents. 

>> Searches backward (downward on screen) for the specified character string or memory 

contents. 

Stop (during a search) Stops searching. 

Refresh Updates the contents of the window with the latest data. 

Modify… Rewrites the memory contents during program execution via the [DMM] dialog box. 

Close Closes the [Memory] window. 

 

The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [Memory] 

window.  The three main functions that can be selected from the context menu are described next. 

 

<1> ASCII display 

Select [Ascii] from the context menu (displayed by right-clicking anywhere on the [Memory] window) to display 

the ASCII display area.  ASCII characters of the memory contents can be displayed and changed in this area. 

 

 

 

 

 

 

 

 

 

 

 

 

 

<2> Selecting the numbering system display 

Select [Bin], [Oct], [Dec], or [Hex] from the context menu (displayed by right-clicking anywhere on the 

[Memory] window) to change the numbering system display of the memory display area (hexadecimal display 

by default). 

 

 

 

 

 

 

 

 

 

 

ASCII display area 

Displayed in 
hexadecimal numbers

Displayed in 
binary numbers 
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<3>  Selecting the display unit 

Select [Nibble] (4-bit units), [Byte] (8-bit units), [Word] (16-bit units), or [Double Word] (32-bit units) from the 

context menu (displayed by right-clicking anywhere on the [Memory] window) to change the display unit of the 

memory display area (byte display by default). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.6 [Watch] Window 
 

This window is used to display the shifts in data values registered.  Select [Watch] from the [Browse] menu or click 

the  button on the toolbar to open the [Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)  Symbol name display area 

This area is used to display variable names, symbol names and types, and tag names of structures or unions 

registered in the [Add Watch] dialog box. 

 

(b)  Data value display/setting area 

This area is used to display and change data values.  The values are updated when execution is stopped. 

 

(c) Function buttons 

(a) Symbol name display area (b) Data value display/setting area 

Displayed in byte units 

Displayed in word units 
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(c)  Function buttons 

Add… Rewrites the watch data via the [Add Watch] dialog box. 

Delete Deletes the selected watch data from the window. 

Up Moves the selected line one line up. 

Down Moves the selected line one line down. 

Refresh Updates the contents of the window with the latest data. 

Close Closes the [Watch] window. 

 

An example in which the [Add…] function button is used to register data to the [Watch] window is shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click 

Area in which the data value numbering 
system is selected 

Area in which the data 
value display size is 
selected 

Enter “P2” (P2 register) and 
click the [OK] button. 
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The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [Watch] window.  

The main function that can be selected from the context menu is described next. 

 

• Selecting the numbering system display 

The data value numbering system can be selected from the context menu (displayed by right-clicking 

anywhere on the [Watch] window). 

Bin Displays the selected line in binary numbers. 

Oct Displays the selected line in octal numbers. 

Dec Displays the selected line in decimal numbers. 

Hex Displays the selected line in hexadecimal numbers. 

String Displays the selected line as a character string. 

Proper (default) Displays the selected line in accordance with the setting of the [Debugger Option] dialog box 

(selected from [Debugger Option] in the [Option] menu) (default: hexadecimal). 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.7 [Register] Window 
 

This window is used to display registers.  Select [Register] from the [Browse] menu or click the  button on the 

toolbar to open the [Register] window. 

 

 

 

 

 

 

 

 

 

 

 

 

(c) Function buttons 

(a) General-purpose 
 register display area 

(b) Control register 
 display area 

Selected line 

Changed to binary display 
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Double-click 

Press the Enter key. 

Enter “0010”. 

Double-click 

Press the Enter key. 

Enter “0010”. 

(a)  General-purpose register display area 

This area is used to display general-purpose registers. 

The plus sign (“+”) indicates a 16-bit register whose display can be expanded.  Double-click “+” to display the 

two register names and register values (“+” changes to “−”).  Double click the minus sign (“−”) to cancel the 

expanded display. 

 

 

 

 

 

 

Register values are changed through direct entry.  Changes are displayed in red and the contents of the 

changes are written to the target memory by pressing the Enter key.  The previous values can be discarded by 

pressing the ESC key. 

 

 

 

 

 

 

 

 

(b)  Control register display area 

This area is used to display control registers. 

The plus sign (“+”) indicates a register whose display can be expanded.  Double-click “+” to display the flag 

names and flag values (“+” changes to “−”).  Double click the minus sign (“−”) to cancel the expanded display. 

 

 

 

 

 

 

 

 

Register values are changed through direct entry.  Changes are displayed in red and the contents of the 

changes are written to the target memory by pressing the Enter key.  The previous values can be discarded by 

pressing the ESC key. 

 

 

 

 

 

 

 

(c)  Function buttons 

Refresh Updates the contents of the window with the latest data. 

Close Closes the [Register] window. 
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The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [Register] 

window.  The two main functions that can be selected from the context menu are described next. 

 

<1>  Add Watch 

Select on the window the name of the register to be added, and select [Add Watch] from the context menu 

(displayed by right-clicking anywhere on the [Register] window) to open the [Add Watch] dialog box.  Check 

that the selected register name is added to the [Name:] column and click the [OK] button to register the 

specified data in the [Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<2>  Selecting the numbering system display 

Select [Bin], [Oct], [Dec], or [Hex] from the context menu (displayed by right-clicking anywhere on the 

[Register] window) to change the numbering system display of the [Register] window (hexadecimal display by 

default). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Displayed in hexadecimal numbers 

Displayed in 
binary 
numbers 

Click the [OK] button. 

“sp” is registered. 

Select “sp”. 
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Press the Enter key. 

Enter “FF”. 

5.8 [SFR] Window 
 

This window is used to display registers.  Select [SFR] from the [Browse] menu or click the  button on the 

toolbar to open the [SFR] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

(a)  SFR name display area 

This area is used to display SFR names and I/O port names.  If the value of an I/O port address is not defined, 

the I/O port name is displayed in a light color. 

 

(b)  Attribute display area 

This area is used to display the attributes of SFRs and I/O ports.  Read/write attributes, access types, and 

absolute addresses are displayed from the left side to the right. 

 

(c)  SFR content display area 

This area is used to display the contents of SFRs and I/O ports. 

Values are changed through direct entry.  Changes are displayed in red and the contents of the changes are 

written to the target memory by pressing the Enter key.  The previous values can be discarded by pressing the 

ESC key. 

 

 

 

 

 

 

 

 

(d)  Function buttons 

Refresh Updates the contents of the window with the latest data. 

Close Closes the [SFR] window. 

(d) Function buttons 

(a) SFR name display 

 area 

(b) Attribute display area 

(c) SFR content display 

 area 
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The menu (context menu) will be displayed if the right mouse button is clicked anywhere on the [SFR] window.  

The four main functions that can be selected from the context menu are described next. 

 

<1> Move 

Select [Move] from the context menu (displayed by right-clicking anywhere on the [SFR] window) to open the 

[Address Move] dialog box.  Specify an address value or SFR name and click the [OK] button in this dialog 

box to move the display start address to the specified address value. 

 

 

 

 

 

 

 

 

 

 

 

Moved 

Enter “ADCR” and click 
the [OK] button. 
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<2>  Add Watch 

Select on the window the name of the register to be added, and select [Add Watch] from the context menu 

(displayed by right-clicking anywhere on the [SFR] window) to open the [Add Watch] dialog box.  Check that 

the selected register name is added to the [Name:] column and click the [OK] button to register the specified 

data in the [Watch] window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

<3> Selecting the numbering system display 

Select [Bin], [Oct], [Dec], or [Hex] from the context menu (displayed by right-clicking anywhere on the [SFR] 

window) to change the numbering system display of the [SFR] window (hexadecimal display by default). 

 

 

 

 

 

 

 

 

 

 

 

 

Select “P0”. 

“P0” is registered. 

Click the [OK] button. 

Displayed in hexadecimal 
numbers 

Displayed in 
binary 
numbers
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<4> Selecting the sort method 

Select [Sort By Name], [Sort By Address], or [UnSort] from the context menu (displayed by right-clicking 

anywhere on the [SFR] window) to change the way the SFR names and I/O port names are sorted on the 

[SFR] window ([UnSort] by default). 

 

 

 

 

Not sorted 

Sorted by names (alphabetical 
order)
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CHAPTER  6   RELATED  DOCUMENTS 
 

 

Document Name Japanese/English 

78K0S/KU1+ User’s Manual PDF 

78K0S/KY1+ User’s Manual PDF 

78K0S/KA1+ User’s Manual PDF 

78K0S/KB1+ User’s Manual PDF 

78K/0S Series Instructions User’s Manual PDF 

Language PDF RA78K0S Assembler Package User’s Manual 

Operation PDF 

Language PDF CC78K0S C Compiler User’s Manual 

Operation PDF 

PM+ Project Manager User’s Manual PDF 

SM+ System Simulator Operation User’s Manual PDF 

78K0S/KU1+ PDF 

78K0S/KY1+ PDF 

78K0S/KA1+ PDF 

Flash Programming Manual (Basic) (MINICUBE2) 

Information 

78K0S/KB1+ PDF 

78K0S/Kx1+ Sample Program (Initial Settings) LED Lighting Switch Control Application Note PDF 
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